
User's Guide 

TUTORIAL 
For use with the Tutorial Database. 

Printing this Tutorial 
You will find it convenient to print out this guide to read as you go through the tutorial. Just right-
click anywhere in this document and select Print, or go to File > Print in the toolbar. From within the 
Help section of any database, click the printer icon in the tool bar. You can return to this page, from 
anywhere in the program, by clicking the top menu title in the upper left pane. 

Below the Tutorial there is a brief User's Guide. This Guide will be printed when you print the 
Tutorial. Be sure to read the Guide and keep it on hand for reference. There is also detailed help on 
the XID Identification System under "Help" in the tool bar. 

Using Attributes of Your Own Choice 
When you insert the DVD, the XID Database Selection window appears which will show all of the 
XID databases on the DVD. When you open the XID program from the hard drive, the XID Database 
Selection window also appears.  

Select the Tutorial Database file and click it. 

The help screen for that database appears in the right pane (in this case providing you with the link to 
the Tutorial).  

If the program is not maximized on your screen, click the Maximize button in the upper right corner 
(across from the database name). 
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The current screen shows the name of the database (Tutorial database) and its interactive menus in 
the upper left, a list of species names in the lower left window, and the database help screen on the 
right (in this case providing you with the link to the Tutorial). 

In this exercise you will identify Canada thistle by saying that it has spiny leaves, rhizomes, and 
wind-blown seeds. These choices could be entered in any order. Note the line above the species list 
pane shows that there are currently 72/72 species remaining in the database. 

If the menus are not shown below "Tutorial database" in the upper left pane, click the small + box to 
the left of "Tutorial database." The first level of the menu structure expands. If a minus sign (-)is 
shown in the box to the left of "Tutorial database," the first level of menus has been expanded. 

Click the small + box to the left of "General." If the black text which appears in the right hand 
window appears distorted, please adjust your screen resolution to 1280 X 1024 or higher. 

Click the small + box to the left of "Spines or Thorns." The attribute menu opens and illustrations of 
the attributes appear in the right hand pane. 

The number (7) appears to the left of the attribute "Spines on leaves and/or stems." This is the 
number of species in the database which display that characteristic. There are five ways in which you 
can select this attribute: 

1. The attribute name appears in a pop-up box when the cursor is placed on any of the images in the 
right hand pane. Left clicking the image of the plant with the spines on the leaves and stem will allow 
you to mark it as "Yes," "No," "Or" (or clear an existing mark). 

2. Right-clicking on the attribute name in the menu will allow you to mark it as "Yes," "No," "Or" (or 
clear an existing mark). 

3. Double-clicking the text (not the box) for "Spines on leaves and/or stems" will mark this attribute 
as "Yes." Double-clicking it again will clear the mark. 

4.The "Yes, " "No," "Or," and "Clear" icons are represented on the tool bar by the icons "Y," "N," an 
eraser for "Clear" and "Or." 

5. Clicking the dotted box to the left of the attribute will allow you to mark it as "Yes," "No," 
"Or" (or clear an existing mark). 

Important note: Attribute marking is the main way in which the user interacts with the 
database. Make sure that you are familiar with all of the methods of attribute marking before 
proceeding. These will be referred to many times in the Tutorial as "the five methods of menu 
marking." 

Using one of the five methods of menu marking, mark the characteristic "Spines on leaves and/or 
stems" as "Yes." 

The number of species shown on the line above the species list is now 7/72. This means that of the 
original 72 species in this database, only 7 meet the criteria selected. The 7 remaining species are 
shown in green (with a check mark to their left) and alphabetized at the top of the species list; the 
eliminated species are shown in red-purple (with a red X to their left) and alphabetized below the 
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remaining species. 

Note: You can select whether the species are alphabetized by common or scientific name by clicking 
"Options" in the tool bar, then "Species List Report" and marking your selection. 

Click the small + box to the left of "Wind Dissemination." The attribute menu opens and illustrations 
of the attributes appear in the right hand pane. 

Using one of the five methods of menu marking, mark "Fruit, seed, or spore wind borne" as "Yes." A 
message appears on the screen: "Family Identified." This means that all species remaining in the 
database belong to the same plant family, in this case Asteraceae. 

Click "OK" to clear the "Family Identified" message. Note the number of species remaining is now 4. 

Click the small box with the minus sign (-) to the left of "General" to contract the menu. 

The next attribute which you will mark is "Rhizomatous." Click the small + box to the left of "Root 
and/or Vegetative Propagule." Note that the attributes in this menu which are not displayed by any of 
the remaining species (they have a frequency number of 0) are shown in gray, while those which are 
still applicable are shown in blue. 

Using one of the five methods of menu marking, mark "Rhizomatous" as "Yes." A message now 
appears on the screen: "Species identified:" and provides you with scrollable photos and description 
of the plant on the right. Click "OK" to clear the "Species identified" message. 

As well as scrolling through the images, you can click on any of the images to go into "Thumbnail" 
view, so that you can see all of the images for that species at once. You can expand any of the 
"thumbnail" images by clicking it. Click the "Close thumbnails" message in the upper left to exit this 
view and return to the main screen. 

You can select what information is displayed for the species on the right side of the screen by 
clicking "Options" in the tool bar, then "Species Description," and making your selections. Your 
choices include: 

Picture: All of the images associated with the species. Recommended! 

Description: Notes and comments about the species. Recommended! 

External links: If present, these can take you to web sites with additional information about the 
species. NOT recommended! 

Picture file: Allows you to see the names of the image files associated with the species. NOT 
recommended! 

Data: Shows the marked attributes for the species. Recommended only for verification! 

Data All: Shows all of the attributes in the menus and how they are marked for the species. NOT 
recommended! 

References: Shows the page number where the species can be found in many popular weed reference 
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books. Recommended! 

References All: Shows all the reference books in the program and the page numbers for those where 
the species occurs. NOT recommended! 

Click "OK" to close the "Species Description Options" window. Click the brush icon in the tool bar 
to clear all marks in the menu tree. The number of species remaining returns to the original number in 
the key (72/72), and all of the menus and attributes return to a blue color. 

You can display the photo and description of any species in the species list by clicking on its name or 
scrolling to it in the species list using the arrow keys. A dialogue box may appear asking what 
information you wish to have displayed (unless you have previously selected the box which says 
"Don't show this dialog before every report"). Select the information you wish to display, then click 
"OK." You can then click "Next remaining" and "Previous remaining" to page through the species, or 
use the up and down arrow keys. 

Using the "Yes," "No," and "Or" Commands 
Using the "YES" command. 

Click the small + box to the left of "Flowers," then click the small + box to the left of "Flower color." 

Using one of the five methods of menu marking, mark "Yellow" as "Yes." A "Y" mark now appears 
to the left of "Yellow," and the number of species remaining is reduced to 25. You have said the 
color of the flower on your plant specimen IS yellow. 

Clear the mark using one of the five methods of menu marking. Note that the number of species 
returns to the original number (72/72). 

Marking more than one attribute in a menu with a "YES" mark causes the attributes to be combined 
as "AND." For example: Mark both "Yellow" and "Purple" as "Yes." The number of species 
remaining is now much fewer than when only "Yellow" was marked (2 instead of 25). You have said 
that your flower is BOTH yellow AND purple in color, or that both yellow AND purple flowers are 
present within the species (these situations could be distinguished by marking the "Multi-colored" 
attribute). 

Clear both marks you have made using one of the methods of menu marking. 

Using the "NO" command. 

Click (don't double-click) "Green," so that it is highlighted. 

Using one of the methods of menu marking, mark the attribute "No." A "N" mark now appears to the 
left of "Green," and the number of species remaining is reduced. You have said that the color of the 
flower on your specimen IS NOT green. Note that the number to the left of "Green" still shows some 
remaining species. This is due to the fact that "NO" marks eliminate only those species/items that are 
marked exclusively for that character (in that menu). To eliminate a species that can occur with more 
than one attribute in a menu, all possible attributes for that species must be marked as "NO" in the 
menu. 
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Click the eraser icon in the tool bar to remove the mark. Note that the number of species returns to 
72/72. 

Using the OR command. 

Right-click the word "Yellow." Mark it as "OR." A RED "Or" appears to the left of "Yellow" and the 
number of species is NOT reduced (a single "Or" has no mathematical meaning). Using one of the 
methods of menu marking, place an "Or" mark on "Yellow-orange." A blue "OR" mark now appears 
to the left of both selections. You have said that you are unsure of the color of the flower on your 
specimen, but that you are sure it is either yellow OR yellow-orange. 

Clear both marks you have made using one of the methods of menu marking. 

Using the images for "OR" marking. 

Click on the words "Petal tip" in the "Flowers" menu. Illustrations of all the types of petal tips appear 
in the right pane. Click on the illustration for "Bilobed," and select "Mark Or." A new window opens 
showing all the petal tips, with a blue box around the illustration of "Bilobed" (it also appears with a 
check mark in the menu on the left). Click the image of any other petal tips you wish to mark as 
"OR" (they will become marked when you click them). Click "OK" when you are done. Use the 
"OR" technique any time you are unsure of the exact answer. This is very helpful for highly variable 
attributes such as leaf shape, plant height, and characteristics open to interpretation like flower color. 

Click the brush icon in the tool bar to clear all the marks you have made in the menus. Note the 
number of species remaining returns to 72/72, and the menus all change to blue. 

Analyze Feature 
In this exercise you will use the Analyze feature to aid in identifying a dandelion (Taraxacum 
officinale).  

Click the "Eye" button on the toolbar. A "List of Useful Menus" appears on the right. This is a list of 
suggestions for attribute menus which will be useful in identifying your plant. The suggestions at the 
top are the menus that are easiest and most likely to separate between the remaining species. 

Click "Flower color" in the list of suggestions. 

The menu structure tree opens to the "Flower color" menu. 

Double-click the word "Yellow" in the "Flower Color" menu (marking it as "Yes"). Note that the 
number of species remaining is now 25. 

Click the "Eye" button on the toolbar. 

Click the words "Life Cycle" in the list of suggestions on the right. 

The "Life Cycle" menu opens in the menu structure. Double-click the word "Perennial" in the "Life 
Cycle" menu (marking it as "Yes"). The number of species remaining is now 8. 
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Click the "Eye" button on the toolbar. 

Click the words "Milky Juice" in the list of suggestions on the right. 

The "Life Cycle" menu opens in the menu structure. Double-click the words "Juice milky" in the 
menu (marking it as "Yes"). The number of species remaining is now 3. 

Click the "Eye" button on the toolbar. 

Click "Root or Vegetative Propagule" in the list of suggestions. 

The "Root or Vegetative Propagule" menu opens in the menu structure. Double-click the word 
"Taproot" in the menu (marking it as "Yes"). The number of species remaining in the database is now 
2 and the "Family Identified" message appears. Click "OK" to clear the message. 

Click the "Eye" button on the toolbar. 

Click "Main Stem Branches" in the list of suggestions on the right. 

The "Main Stem Branches" menu opens in the menu structure. Double-click the words "Main stem 
unbranched" in the menu (marking it as "Yes"). 

A "Species Identified" message now appears and the species image comes up on the right. Click 
"OK" to clear the message. 

Clear all marks in the menus by clicking the brush icon in the tool bar. 

Marking attributes of your choice with "YES," "OR," or "NO" can be combined in any sequence with 
asking the program for suggestions (using the Analyze Feature). 

Data Distribution 
Expand the Flowers menu (by clicking the small plus (+) box to the left). Expand the Flower Color 
menu (by clicking the small plus (+) box to the left). 

The number of species in the database with each of the attributes is shown at the left of the attribute. 
This screen tells you that for this database "Yellow" and "White" are common flower colors, but 
"Red-orange" and "Brown/black" are rare flower colors. Note that any time an attribute is marked the 
distribution numbers for all the attributes reflect the newly reduced species list. Note also that the 
total of the distribution numbers in a menu is often greater than the number of species in the database. 
This is due to species that are marked for more than one attribute in the menu. 

Contract the "Flowers" menu by clicking the minus sign (-) to the left of "Flowers." 

Show Marks 
Expand the "General" menu, then expand the "Milky Juice" menu. 

Mark "Juice milky" as "Yes." 
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Expand the "Leaves" menu, then the "Leaf Arrangement" menu. 

Mark "Opposite" as "Yes" 

The " Family Identified..." message appears. Click "OK" to clear the message. Click the two 
overlapping boxes (with check-mark/red X) icon on the tool bar (the fly-over window for this icon is 
Marked & Eliminated) . At the top of the window on the right it shows you what marks you have 
made in the menus, i.e., "YES" for Juice milky and "YES" for Opposite. No species will appear in 
the "Eliminated Species" section of this report unless you have eliminated them using the "Eliminate" 
command discussed later. 

Show Common Attributes 
Click "Database" at the top of the screen and select "Common Attributes." The attributes shown in 
the right pane are the attributes that are shared by the remaining (un-eliminated) species. 

Clear all marks with the brush icon in the tool bar. 

List Species and View References 
Click the "Item/Species List" icon (just to the right of the printer icon) in the toolbar to view a 
scrollable list of the species in the database (along with a selection of information and images) in the 
right pane. Each time this button is clicked, a dialogue box appears asking what information you wish 
to have displayed (unless you have previously selected the box which says "Don't show this dialog 
before every report"). Select the information you wish to have displayed, then click "OK." 

Images of the species that have not been eliminated are presented (this may take a while), allowing 
you to scroll down through them. If the list of species is too long for all the images to be displayed, 
clicking on "More" at the bottom of the scrolled images will display the next group of images. 

The list displayed will be only those species which have not been eliminated by attribute marking. 
Along with the species names, you may have chosen to view a picture of the species, descriptive 
information, the filenames of the pictures in the database, and a list of references with page numbers 
where you may look up the species. 

Show Image Gallery 
Click the Gallery button (four small squares) on the toolbar. This feature allows you to display 
images of more than one species at a time for the purposes of comparison. You can change the size of 
the images, how many are presented (up to 100), and whether the species name is displayed with 
each image by going to "Options" in the tool bar, then "Gallery" and making your selection. Since the 
images are of various sizes, there may be some blank spaces in the gallery. You can also change the 
way that the gallery is presented by moving the "Split Line" that divides the right and left sides of the 
screen. If the names are included, the images are presented in a vertical arrangement. If names are not 
included, the images may also be presented in rows, depending on the width of the images and the 
width of the right window. 

Go to "Options" in the tool bar, then "Gallery" to select whether or not to show the names. 
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In the gallery display you can click once on an image to go into "Thumbnail" mode. Closing 
"Thumbnail" mode returns it to its previous size. 

Show Distinctive Attributes 
Right-click on the top menu title (Tutorial database), then click "Expand menu tree." Mark one or 
more menu attributes of your choice, until the number of species remaining is around 5 to 15. 

Right-click on one of the remaining species in the list and select "Distinctive Attributes." 

A screen titled "Distinctive Attributes of (name of species that was highlighted) appears. The number 
of species with each attribute is listed on the left hand side of the screen in order of increasing 
frequency. Those attributes with a "1" at the left are possible only for the species selected (and named 
at the top of the screen). Attributes with a "2" at the left are possible for the species selected and for 
one additional species from the species list, and so on. This screen should be thought of as containing 
features the species MAY have. These features are not necessarily mandatory. For example, a plant 
species may have white flowers and blue flowers; the blue flowers could be a unique feature, but 
your specimen might only have white flowers. If your specimen had blue flowers, however, this 
screen would have provided a good clue. 

Click the brush icon in the tool bar to clear all marks in the menus. 

Eliminating Species of Your Choice 
Expand "General," then "Spines or Thorns." 

Double-click the attribute "Spines on leaves and/or stems" in the menu structure. 

Assume you know the specimen you are trying to identify is NOT prairie wild rose or buffalobur. 

Highlight each of these species in the species list and click the blue "X" button on the tool bar to 
eliminate those species from consideration. This leaves a yellow triangle mark to the left of each of 
these species and moves them into the alphabetized list of eliminated species below the list of those 
remaining. Eliminating species in this manner can be very helpful. Now if you were to click 
"Analysis," the suggestions provided will be different than they would have been, since the program 
now tells you how to distinguish between only those that have NOT been eliminated. 

Click the two small overlapping boxes with the black check-mark and red X ("Marked & 
Eliminated") icon in the tool bar. This brings up a list of the attribute marks made and below it the 
names of those species that have been marked as eliminated. Clicking on one of these names calls up 
a menu box that allows you to find the species name on the species list, un-eliminate the species, or 
access descriptive information. 

Clear all marks in the menus using the brush icon in the tool bar. 

Species Description 
Right-click on any name in the species list, then click "Description." (If the dialog box allowing you 
to select the information you wish to have presented for that species does not appear, it is because the 
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"Don't show..." box is checked in "Options" >"Species Description" in the tool bar). After selecting 
the information you wish to display, click "OK." 

This screen gives you general information about the species which was highlighted. A picture of the 
species may be displayed as well as descriptive information, the name of the image file names for the 
species, the attribute data that has been entered in the database, and a list of references with page 
numbers for further information on the species. 

Right-clicking on a species name in the list can also allow you to eliminate the species or show its 
"Distinctive attributes" in comparison to the other remaining (non-eliminated) species. This feature 
will also work on species that have been eliminated. 

Forgiveness Feature 

If you parse the database down to a small number of species and the one you are looking for does not 
appear, you are facing one of the following possibilities: 

A. The species you are trying to identify may not be in the database.  

B. You may have made an error, (go to "Database," "Marked Attributes and Eliminated Items," to 
review what you have done).  

C. There may be an error in the data.  

Problems B and C can be eliminated by going to "Options" in the tool bar, then "Forgiveness Level." 
Selecting "Level-1" will allow any one datapoint that you have selected to be incorrect without 
eliminating your species. Selecting "Level-2" will allow any two datapoints that you have selected to 
be incorrect without eliminating your species, etc. The "non-eliminated" species occur in alphabetical 
order in the species list, with the number of incorrect attributes to their left. Clicking any species will 
allow you to see which attribute is incorrect and has been "Forgiven." 

Program Help 
Select "Help" from the "Help" menu at the top of the screen. No matter where you are in the 
program, you can click "Help" which provides you with detailed information that explains how to use 
the XID software. 

Click the black (lower) "X" button in the upper right corner to close the Help screen. 

Notes 
If you are sure your specimen has an attribute that is not in a menu (but the menu appears with other 
attributes), your species might not be in the database or the author may have chosen not to include 
that attribute. 

Each key includes hundreds of thousands of data entries and errors are inevitable. If you believe you 
have found an error, please Contact Us so that we can correct the error in future updates.
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In the database, "false" data may be used when it will make the program more efficient for the 
unskilled user. For example, dandelion is marked as both 5 (the correct answer) and >10 (the way it 
looks) in the "Number of Petals" menu. Because of this use of false data, the attributes marked for a 
species may not constitute its true botanical description. 

Many families have more than one name (for example, Asteraceae and Compositae) and either one 
can be selected in the "Family" menu. To eliminate such a family however, both names must be 
marked as "NO" in the "Family" menu. 

If you want to look up information about a plant, in most cases it is better to use the scientific name 
rather than the common name. If the scientific name has recently changed, you will be able to find 
the old name in the "Synonymy" menu and go directly to the species. All synonymy is based on the 
Synthesis of the North American Flora produced by the Biota of North America Program (BONAP) 
2008. BONAP Home Page 

Printing this Guide 
You may find it convenient to print this guide to keep on hand as a quick reference. Just right-click 
anywhere in this document and select Print, or go to File > Print in the toolbar. There is much more 
detailed help available from with within the Help section of any database. Help can be accessed from 
within the program by pressing F1 at any time or selecting Help from the menu help icon on the 
toolbar. From within the Help section of any database, you can also click the printer icon in the tool 
bar. 

Description 
These keys to identify plants are comprised of a set of databases designed to run in the expert system 
software produced by XID Services, Inc. The databases are supplemented by color images of each 
species and line drawings to illustrate the terminology used within the menus. Such programs offer 
many advantages over traditional dichotomous keys. While originally produced to increase speed and 
ease of use, they also provide the ability to easily update the data and images and are much less 
expensive to produce and more compact than hard-copy guides. These databases include a large 
selection of plant characteristics from which to choose. In general, much more data are included on 
each plant than is necessary to identify it. With this abundance of data, the user can identify a plant 
using the characteristics most obvious and easy to describe. With each characteristic entered by the 
user, the program eliminates all species that do not have the combination of features entered. If you 
are interested in producing your own keys, to any subject matter, using the XID system please 
Contact Us 

BOTANICAL TERMINOLOGY 

The use of botanical terms has been kept to a minimum; however, some terms used to describe plants 
cannot easily be replaced by "common" words. Definitions of terms, and usually illustrations, are 
provided throughout the menus of characteristics. Terms are also cross referenced to an excellent 
illustrated glossary of terms, PLANT IDENTIFICATION TERMINOLOGY (Harris and Harris, 
1994, ISBN# 0-9640221-5-X). 

SPECIES INFORMATION 

Information provided for each species may include synonyms, ethnobotanic uses and additional 
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information to distinguish the plant from similar species and to separate varieties. If you are looking 
for a scientific name and cannot find it in the species list, try the Synonymy menu. All nomenclature 
used is based on the Synthesis of the North American Flora 2008 by John Kartesz, Biota of North 
America Program (BONAP), Chapel Hill, NC. Keep in mind that the data for each species is also 
available from within the XID database and constitutes an extensive botanical description. 

HELP 

The instructions on the use of the XID software are all included in the Program Help. To access 
program instructions, select "Help" from the Help icon in the tool bar. Scrolling down through the 
text of Help information provides a detailed review of how to use the various features of the 
software. 

ANALYSIS 

One of the most useful and powerful features of the program is the Analyze Feature. It provides a list 
of the easiest and most effective menus of characteristics to distinguish between the remaining 
species that have not yet been eliminated. In the Broadleaf database, the Analyze feature may be used 
at any time. However, in the database for Grasslike Plants, it is important not to use the Analyze 
feature until the plant family for the plant has been identified. In the Grasslike database, using the 
Analyze feature before the family is identified runs a high risk of failing to identify the plant because 
it may lead the user to an attribute menu for the wrong family. If the correct family is not known, one 
should first go to the Family Key menu; if the family is known, go directly to the appropriate family 
menu and the program will identify the family after the first characteristic is entered. 

INTERACTIVE IDENTIFICATION 

When using the program, SELECT SPECIMENS THAT ARE OF AVERAGE SIZE FOR THAT 
POPULATION. Many of the easiest characteristics for the untrained user will be found in the 
"General" menu. The user should first enter the most obvious or unusual one or two characteristics of 
the plant and then use the Analyze feature to get leads for where to go from there. If you are not sure 
whether a characteristic fits the plant to be identified, DO NOT mark it. If you are not sure which 
characteristic best fits the plant (a blunt vs. rounded leaf tip, for example), USE THE "OR" 
FEATURE to mark them both and ensure that the correct species will not be eliminated from 
consideration. Also use the "OR" feature for dimensions of leaves, etc. to avoid problems from 
specimens outside the usual size for that species. When using the Analyze feature, the user may 
select any of the menus listed or select a different menu from the menu tree. Unless you have 
extensive training in plant terminology, avoid the more complicated or technical characteristics; they 
usually aren't needed anyway. Due to the large number of characteristics to choose from, there are 
literally hundreds of thousands of possible paths to identify the same plant. USE WHAT YOU 
KNOW, WHAT IS MOST OBVIOUS, AND MOST UNEQUIVOCAL. 

PICTURES AND DESCRIPTIONS 

Once you have reduced the number of remaining species to a relatively small number, review the 
photos and/or descriptions using the "Gallery" or "Species List Report." It can take as many steps in 
the menus to reduce the number of remaining species from 16 to 1 as it does to reduce the number 
from 400 to 12!! These extra steps can greatly increase the possibility of making an error (especially 
since these species have greater similarities). Once you have decided on the identity of your 
specimen, use the page number guide to the references included in XID as well as other methods 
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(such as internet searches) to confirm your findings. 

REFERENCES 

The "References" section (click the R on the tool bar) allows you to see the ISBN # for the references 
used in the program so that you can order those which you would like to add to your library. You can 
also "drag and drop" the references in the list so that those which you own will appear at the top. 

This program is a tool to help in the identification of plants, and as with any key, should not be 
considered a final authority. Identifications should be checked against plant descriptions. A list of 
references and page numbers describing the plant may be called up from the Species List. 

We have made every possible effort to eliminate errors from the data. In the event you find data 
errors, we encourage you to Contact Us so we may correct them in future versions. The data and 
images are being continually updated for inclusion in future versions. Please contact us if you have a 
better image of any species that you would like to contribute. Photographic credits are included on 
any images used in the databases; however, only non-copyrighted images are accepted for this 
purpose. 

Acknowledgments 
This program would not have been possible without the effort and talents of Charles Butts who 
developed the software for the original versions. 

Many of the photographs of species used in these programs were assembled through extensive effort 
and travel by Bruce Barnes of Flora ID Northwest. As a result of years of work, he has developed a 
library of images of virtually every plant species in the Pacific Northwest. These images are available 
in his comprehensive databases for all native and naturalized plants in the states of: Washington, 
Oregon, California, Idaho, Montana, Nevada, Utah, Colorado, Wyoming, North Dakota, South 
Dakota, Minnesota, Kansas, Wisconsin, Nebraska, and Iowa as well as the Canadian Provinces of 
Alberta, British Columbia, Saskatchewan, and Manitoba. 

Bruce Barnes can be contacted at: 
Flora ID Northwest 
PO Box 1831, Pendleton, OR 97801 
541-276-5547, FAX 541-276-8405 
Contact Flora ID Northwest 
Flora ID Northwest Home Page 

Line drawings illustrating definitions of terms in the menus are the copyrighted property of XID 
Services, Inc. 

Herbarium facilities have been made available at Oregon State University, the University of 
Montana, University of British Columbia, University of Wyoming, Brigham Young University, 
University of Colorado, Washington State University, University of Washington, Utah State 
University, and West Virginia University. The herbaria staff have in all cases been very helpful. 

Special thanks to: Dr. Alex Ogg for all of his time and effort in attempting to acquire photos of 
common weeds from members of WSSA for use in this program, Dr. David Hall for his considerable 
contributions of time and expertise in helping to acquire images of weeds in Florida, and to Dan 

Page 12 of 13XID Services, Inc.

6/30/2009file://C:\MUDESCD\Xidw\Demo\XID\guide.htm



Tenaglia for the generous contribution of images from his excellent web site on Missouri Plants. 
Missouri Plants Home Page 

We are deeply indebted to the many photographers and agencies listed below who have graciously 
allowed us to digitally copy their slides for use in this program, making the end result a truly 
collaborative effort. Due to their generosity, images included in the program may be used for any 
non-profit educational purposes without obtaining additional permission, however all images must 
retain the photographers credits for all usages. 

Photographers and agencies whose photographs may be included in this program include: Dirk V. 
Baker, Bruce Barnes, Bruce Barbour, Drake Barton, Robert Bellm, Howard Black, John Boyd, David 
Bradshaw, John Cardina (Ohio State University), Randall and Lisa Currie, Rick Boydston, Jim 
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Flora is the quintessential reference. BONAP Home Page 

How to Contact Us 
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PO Box 272 
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Phone 800-872-2943  
Contact Us 
XID Services Home Page 

This program is produced using software created and produced by XID Services, Inc., Copyright 
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